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Defining Custom Data Fields 

 
1. Start the application and click on the Configuration & Preferences feature from the main 
application window 

 

 
 

2. Click on the Data menu from the Configuration & Preferences window and 
then click on the Define Custom Fields menu 

 

 



 

 
 
3. You may rename the Section, Lot and Grave field names if necessary, but 

there are some restrictions. You cannot move the existing names around, 
meaning you can’t have ID1 = Lot and ID2 = Section, these are reserved 

words, so be careful what you name these fields. 
 

4. There are five already available fields in the database that you may 

redefine as you like. These are text fields, so anything you input will be fine. 
These are located in the lower left corner of the custom fields box. 

 
5. In the grid on the right portion of this window, you can create completely 

new data elements. These fields can be any one of four data types: 

 Text – any data you want, up to 255 characters per field 
 Integer – any non-decimal value 
 Currency – any amount 
 Date – a valid date, must contain month and day, and must be greater than 

1/1/1753 

So if I want to create a brand new custom field named "Spouse Name" I 
might do the following: 



 

 
You should refrain from naming ANY of your custom fields using special 
characters. Please limit your custom field names to letters of the alphabet, 

numbers, and the space key only. 
 

6. Once you’ve inputted all your custom data field names, click on the SAVE 
button, but be aware that any new custom fields you define cannot be 

deleted once they are created. 
 

7. If you need to reset the ID and Custom 1-5 fields to their original names, 
you can use the Reset to Defaults button to do this. 
 

  



Configuring Cemeteries 

 
1. Click on the Configuration & Preferences feature from the main application window 
 

 

2. Click on the Data menu and choose Cemetery Manager 
 

 



 

 
 
3. Input as many cemeteries as your organization needs, keeping in mind that you won’t 
have separate databases, so all the records will be co-mingled, but you will then be able to 
create separate maps for each of the cemetery records here 
 

 
 
4. Update the sort number to identify how you want your cemeteries displayed in various 
parts of the application 
 
5. Do not leave blank rows between cemeteries, this will cause problems with the database 
 
6. To remove any data in the grid, use the CTRL-X keys on your keyboard which will erase 

the contents of a cell 
 
7. When you’re all finished, either click File/Save or just close the window and it will ask if 
you want to save your work 



 

 
 

 

  



Configuring Lot Types 

 
1. Click on the Configuration & Preferences feature from the main application window 
 

 
 
2. Click on the Data menu and choose Lot Type Manager 
 

 



 

 

3. Input as many lot types as your organization needs 
 

 
 
4. Provide a price if you intend to use this information for invoicing and billing purposes 
 
5. Update the sort number to identify how you want your lot types displayed in various 
parts of the application 
 
6. Do not leave blank rows between lot types, this will cause problems with the database 
 
7. To remove any data in the grid, use the CTRL-X keys on your keyboard which will erase 
the contents of a cell 
 
8. When you’re all finished, either click File/Save or just close the window and it will ask if 

you want to save your work 



 

 
 

  



Importing Existing Data 

 
1. IMPORTANT!!! Before you do this, please be sure to assign all your custom data fields 
(if applicable) 

 

 
 
2. Click on the Configuration & Preferences feature from the main application window 
 

 
 
3. Click on the Data menu and choose Import Data from Tab-Delimited Text File 



 

 
 
4. Your file must be a text file, with all data elements separated by a tab. The best way to 

do this is to save your data from Excel into a tab-delimited format. You should also have 
separate files for each cemetery and lot type, as the import process assigns all data in a 
single import file to just one cemetery and one lot type. 
 

 
 
Your data file should contain a single header row. 

 



 
 
5. Choose your cemetery and lot type from the drop down boxes at the top of the window 
 

 
 
6. Click on the button in the top right corner to select your import file 
 
7. The application will attempt to automatically map the available data columns with the 

data in your import file, but likely you will need to choose the appropriate data mapping 
columns within the grid 
 



 
 



 
 
8. Once you have all your data elements mapped, click on the button in the bottom right 
corner of the window to begin the import process 
 



 
 
9. You will be asked if you want to completely wipe out all the existing data in your 
database before the new file is imported. 
 

 
 



a. If you answer YES, all data is wiped out and only the data from your import file will exist 
b. If you answer NO, all data is left intact and your new data file is appended to your 
existing data 
 
The program will then need to close and you will need to re-open. 
 

 
 

 

  



Networking/Sharing Your Data 

 
1. IMPORTANT!!! Before you do this, please perform a data backup (see those instructions 
in another section of this document) 
 

 
 
2. Click on the Configuration & Preferences feature from the main application window 
 
3. Click on the Data menu and choose Set Data Folder 
 



 
 
4. By default, your database is stored in the My Documents folder of the user that installs 
the software. This, of course, is no good if another user logs into your computer under a 

different name, or tries to access your data from another computer on your network. So you 
would typically have your network administrator assign you a shared network folder so you 
can store your Crypt Keeper data there for shared access. 
 

 
 
5. Once you know the shared folder name, input that into the text box in the Set Data 
Folder window and then click on the button in the lower right corner to Locate New Data 

Folder 
 



 
 
6. You will have to ensure that the software is installed on every computer that intends to 
access the data, and all the computers will have to set this same data folder to share the 

data 
 

 

  



Inputting Data 

 
1. From the main application window, click on the feature to View/Edit Your Data 
 

 
 
2. A new screen appears, click on the NEW menu at the top of the window 
 

 
 
3. A window opens with all of your available data fields waiting for you to input data. You 
can input as much or as little data as you like, but you must at least provide the location 
ID’s (Section, Lot, Grave) at a minimum. Keep in mind that these ID’s are used to link your 

database records to your map (if you choose to create maps) so be sure to maintain 
consistency. 



 

 
 
4. When you get to the purchaser section: 

 To input a new purchaser, click the dropdown and choose the option to 
Add New Purchaser. The boxes will become enabled, allowing you to 
input data. 

 To choose an already inputted purchaser, click the dropdown and 
select the purchaser from the listing and all the boxes will then 

populate with the purchaser data on file 

 



 

5. When you get to the deed and purchaser information, if you want to 
manually input this data, press the F7 key on your keyboard to unlock 

those data fields, or you can use the BILLING menu to create an invoice 
which will fill in those boxes for you based on invoice information. 

 
6. When you get to the custom fields in the lower left corner of the window, you’ll notice 

that the Undertaker and the Cause of Death fields have drop down boxes. These are listings 
of already inputted information that you can quickly choose from instead of re-typing that 
information. 
 
7. When you are done inputting data, you can click the File/Save menu. 
 

 
 
8. To input more records you can press the ESC key on your keyboard to clear the screen 
for new entry or use the File/Clear menus. 
 
9. You can add images to your data records, but you must first SAVE your record before you 
can add images (this is discussed in detail in another section of the document) 
 
10. Closing the window takes you back to the View/Edit Your Data window 
 

  



Searching Existing Data 

 
1. From the main application window, click on the feature to View/Edit Your Data 
 

 
 
2. A new screen appears, click on the SEARCH menu at the top of the window 
 

 
 
3. You have three ways to search the database 

 a. The top box is a keyword search, where you can input one or more 

keywords and any matching data will appear in the results box 



 

 

 b. The middle section of three boxes is to search based on the location 
ID’s (Section, Lot, Grave) 

 

 

 c. The bottom section of boxes is to search dates within your database 

o i. DOB = date of birth 
o ii. DOD = date of death 

o iii. DOI = date of interment 



o iv. DOP = date of purchase 

 

 

 
4. Any matching records for your search are listed in the search results box 
 
5. Click on the blue record ID of any record in this listing to view the full details of that 
record 
 

 
 



 
 

  



Editing Existing Data 

 
1. From the main application window, click on the feature to View/Edit Your Data 
 

 
 
2. Before you can edit a record, you must first search for the record, see the instructions 
above this section to use the search feature 
 

 
 



 
 

 
 
3. Once you’ve searched for a record and clicked on its record ID you can click on the EDIT 
menu at the top of the window 
 



 
 
4. A window opens with all of your available data fields filled in with already inputted data. 
You can edit this data any way necessary. 
 

 
 
5. When you get to the purchaser section: 

 To input a new purchaser, click the dropdown and choose the option to 
Add New Purchaser. The boxes will become enabled, allowing you to 

input data. 



 To choose an already inputted purchaser, click the dropdown and 

select the purchaser from the listing and all the boxes will then 
populate with the purchaser data on file 

 
 
6. When you get to the deed and purchaser information, if you want to manually input this 
data, press the F7 key on your keyboard to unlock those data fields, or you can use the 
BILLING menu to create an invoice which will fill in those boxes for you based on invoice 

information. 
 
7. When you get to the custom fields in the lower left corner of the window, you’ll notice 
that the Undertaker and the Cause of Death fields have drop down boxes. These are listings 

of already inputted information that you can  
quickly choose from instead of re-typing that information. 
 
8. When you are done inputting data, you can click the File/Save menu or you can simply 

close the window 
 



 
 

  



Managing Purchaser Records 

 
1. Click on the Configuration & Preferences feature from the main application window 
 

 
 
2. Click on the Data menu from the Configuration & Preferences window 
 

 
 
3. Click on the Purchasers Manager menu 



 
4. Edit the data in this grid as necessary 
 

 
 
5. If you notice you have duplications on the grid, you can use the Merge Purchaser Records 
feature via the File menu which will consolidate this information for you 
 

 
 

 
 
6. To remove any data in the grid, use the CTRL-X keys on your keyboard which will erase 

the contents of a cell 
 
7. If you need to remove a purchaser record completely, use the File/Remove menu 
 
8. When you’re all finished, either click File/Save or just close the window and it will ask if 
you want to save your work 
 

  



Creating Cemetery Maps 

 
1. From the main application window, choose the feature to Create/Edit Your Map 
 

 
 
2. If you have more than one cemetery defined, you will be asked to identify the cemetery 
you want to work with for map creation/editing 
 

 
 
3. If you haven’t yet done this, you’ll find a default grid created for you of 50 columns by 50 
rows, otherwise it will display your already designed map for you 
 



 
 
4. You can increase or decrease the size of your overall map by clicking on the Map menu 

and choosing the Maximum menu 

 Columns = how many columns of data do you want displayed in your 
map 

 Rows = how many rows of data do you want displayed in your map 



 
 

5. Keep in mind that you don’t want to have a lot of unused space around 
your map as this will slow the display of your map, just create enough 

rows/columns to properly display your map 
 
6. You’ll notice that all graves are displayed in a horizontal orientation. This cannot be 
changed. The top of the screen will not necessarily be “north”. You will have to adjust your 
rotation accordingly. 
 
7. You’ll notice that the graves are all of one size. We understand that you will have 

different physical sized graves in your cemetery, but for the purposes of this simplified map, 
the display will appear that all are of equal size. If you have a section of your map that is 
just for cremations, for example, you may want to do that section as a completely different 
cemetery so that you can have its own map for that section. 
 
8. You can assign three different types to each cell of your grid/map 

 Unused – this will appear as a green cell, meaning that it’s a simulated 
grassy area where nothing will exist 

 Path/Road – this will appear as a black cell, meaning this represents 

an object that is not grass and not a grave 
 Usable Lot (Grave) – this will appear as a white cell, where you can 

assign a grave identifier (Section,Lot,Grave) 



 
 
9. To assign a type to a cell, position your cursor over the cell that you want 

to modify, ensuring that cell has the cursor rectangle focused on it, and then 
use the ASSIGN menu’s first three selections accordingly 

 

 
 
10. If you create a cell as a usable lot (grave) and it becomes white, you can then type in 
that cell, and you should then assign your grave identifier (ex. A,1,1). The grave identifiers 
are a three piece grouping, and you must use a comma between each identifier, even if you 
aren’t using all three. For example, if you’re only using Section and Grave and not Lot, you 
might input: A,,1. This is necessary to link the map contents to the database records upon 
map viewing. 
 



 
 
11. If you want to assign an entire group of graves (a lot), you could use the feature on the 
left hand side of the map editor window. Here you would input the section and the lot IDs, 
and then in the Grave grid you would assign the values for each of the graves in that lot 
assignment. Use the ASSIGN menu and Configure Grave Assignment Grid menu to 
determine the number of graves in your lot and how they should be oriented 

(rows/columns). Once you have all that configured, move your cursor onto the grid into the 

top/left most corner of where you want the assignment, ensuring that the cell is 

indicated with the rectangle indicator, and then either press the F9 key on 
your keyboard or use the Assign/Assign Using Section/Lot/Grave Identifiers 

Grid menus. Once you do this, you’ll notice the “Lot” value increases by 1. 
This is so that you can move on to the next location on your map and press 

F9 again, speeding up map creation. 
 

 
 



 
 

 
 



 
 
12. You can highlight multiple cells at once if you want to assign types in bulk. For example, 

if you want to make a road in row 7 stretching from column 1 to column 10, you could 
highlight all those cells with your mouse and then use the Assign menu to assign the 
road/path cell type. 
 

 
 
13. You can insert or delete rows and/or columns using the MAP menu. These insertions or 

deletions would happen at the current point of the highlighted grid cell, so be very careful 
where your cursor is before you use these features. 



 
14. If you are also a user of the Online Version, you could use the Export menu to save your 
map here for uploading to the Online Version. 
 
15. Once you’re done editing your map you can just close the window to save the map 
structure. 
 

  



Viewing Cemetery Maps 

 
1. From the main application window, click on the feature to View/Edit Your Data 
 

 
 
2. A new screen appears, click on the VIEW MAP menu at the top of the window 
 

 
 
3. If you have more than one cemetery configured, you will be asked to choose which 
cemetery map you want to view 
 



 
 
4. The map will be displayed and automatically color coded based on the data in your 
database. In order for the color coding to work properly, your map must have the 
Section,Lot,Grave identifiers configured to mirror the data in your database. For example, if 
you have a record in the database with Section = A, Lot = 1, Grave = 1, then the map 

grave ID must be: A,1,1 
 

 
 
5. Color coding is as follows: 

 Records that have no interred or sales information will be colored 
white. 

 Records that have an interred date will be colored red. 



 Records that have an interred name or a purchaser name, but no 

interred date and no sold date, will be colored yellow. 
 Records that have no interred information but have a purchase date 

will be colored blue. 

6. As you click on graves of the map, any record that exists in the database 
will be displayed in the small grid at the top of the map screen. You can 

have more than one record assigned to a single grave. If you double-click 
your mouse on one of the records in this grid you will be shown all the 

details of that particular database record. 
 

 
 
7. You can change the zoom level of the map by clicking on the ZOOM menu. This will affect 
how large the graves will be when you print the map. 
 



 
 
8. Clicking on the CEMETERY menu allows you to choose a different cemetery map (if you 
have more than one cemetery created) 
 
9. When you’re done viewing the map, just close the map window 
 



Adding Images to Records 

 
1. You can add images to either NEW records or records you’re EDITing. Use the 
instructions above to learn how to add or edit records. A new database record must be 

saved before you can add images. 
 
2. Once the record is displayed, click on the FILE menu and choose the option to View 
Images for This Record. 
 

 
 
3. Another window opens. If you have images already uploaded for this record, they will be 

listed here and the first image is displayed for you in the image pane. 
 



 
 
4. To add a new image click the File menu and then Load New Image. You’ll be asked where 

the image exists on your computer. Find the image and click OPEN. 
 

 
 



 
 



 
 
5. Repeat step 6 until all images for this record are uploaded. 
 
Now when you view your records the images also appear... 
 



 
 

  



Creating Deeds 

 
1. You can add images to either NEW records or records you’re EDITing. Use the 
instructions preivously to learn how to add or edit records. A new database record must be 

saved before you can add images. 
 
2. Once the record is displayed, click on the BILLING menu and then the DEEDS menu. 
 

 
 
3. Before you create a deed, you should ensure the deed template will meet your needs. 
From the DEED menu, choose Configure Deed Template. 

 The deed template is a very simplified grid that allows you to use 

keywords to pull in your database record data fields by way of 
parameters. A sample template is already configured for you, but you 

can adjust this template any way you deem necessary. 
 When you are done configuring your deed click on the SAVE button. 

This will add the template to the available listing of templates. You 
may create as many deed templates as you like, and then choose the 

different templates by way of the dropdown box at the top of the 
template window for editing. 

 When editing an existing template, you can also delete the template as 
a new button appears for DELETE. 



 
 



Be sure to name your deed template before you save it... 

 

 
 
Then in the body of the deed, you can define if the row of text should be left 

justified, centered, or right justified... 



 

 
 

Then in the body of the deed, you can define what you want displayed, 
which includes keywords that can be used to automatically fill in data from 

your database record... 



 

 
 



The available keywords are listed on the right side of the window... 

 

 
 
And if you decide you need to shrink your text a little so you can fit more 

information, be sure to adjust the font size for the document... 



 

 
 

4. When you are ready to create a deed, click on the BILLING, DEED and 
Generate Deed menus. You’ll then choose the template you want to use. The 

deed will be generated in PDF format and will open for you automatically for 
either printing or saving to a different location on your computer. 

 

 



 

 
 

 
 

 

  



Creating Invoices 

 
1. With the database record already inputted and saved, click on the BILLING menu and 
then the Create/View Invoice for Selected Record. 

 

 
 
2. If you’ve already created an invoice for this record, it is displayed in a read-only format 
where changes would not be possible. Otherwise, it will display a new invoice where you can 
change the variables as needed. 
 
3. The first row of the invoice details contains the information based on the lot type pricing 
that you provided via the Lot Type Manager. You can change this value as needed. 
 



 
 
4. When you’re satisfied with the invoice, use the File/Save menus. This locks the invoice so 

no further edits are possible. 
 



 
 
5. To print the invoice, click on the File/Print menus. 
 

 
 



 
 
6. You can apply payments to your invoices by: 

 Click on the BILLING menu 
 Accounts Receivable Manager 

 Pull up the purchaser record for the invoice/payment. Once it’s 
selected, all invoices for that purchaser will be displayed in the Activity 

pane 
 There are three tabs 

o Activity – lists all invoices for this purchaser 
o Process Payments – allows you to input payments received 

o Global Settings – allows you to edit how the billing feature works 

 Click on the Process Payments tab which will display all outstanding 
invoices and how much is owed. You can then input the Payment 



Received amount and the date received. Click on the APPLY PAYMENT 

button when complete. 
 When you’re all done with payments you can send out statements 

using the REPORTING feature. 

 

  



Running Reports 

 
1. From the main application window, click on the REPORTS feature 
 

 
 
2. A window appears with a grid in the center. 
 

 



 
3. There are several reports already created and ready to run for you. You can access these 
pre-created reports via the STANDARD menu. 

 List Interred 
o By Location ID 

o By Name 
o By Date of Birth 

o By Date of Death 
 List Cemeteries 

 List Lot Types 
 Outstanding Receivables (any cemetery record where the amount paid 

is less than the amount owed) 

 Family Associations 
 Statements (only prints statements for records where you generated 

an invoice) 

 
 

4. For those that would like to create their own custom reports 

 In the Advanced Reporting grid: 

o In the Report Column, choose the data fields you want displayed 
on your report 

o Assign a sort order to Report Columns only for data fields where 
sorting is necessary 

o If you want to narrow down your report results, you can set 
conditions and filters. For example, if you wanted to return 

records only from Section A of your database, you could assign: 
 Report Column = “Section” 

 Condition = “=” 
 Filter = “A” 



 Once you’ve defined all your report parameters, click on the 

ADVANCED menu to save your report. You’ll be asked to name the 
report. 

 You can then click on the PRODUCE REPORT button to display the 
report results. 

 If you want to load a previously saved report, click on the ADVANCED 
menu and then the Load Report option. 

In the example custom report below, I've added just a few data columns and 

assigned sort orders. Please do not assign the same sort order value to more 
than one data column or you will get errors. You'll also notice I am filtering 

this report to return only records with an Interred Last Name greater than 

blank (or empty), which means only those with an existing last name will 
appear on the report. 

 

 
 
Now if I want to instead return my records based on the interment date, I 

would change the filters as illustrated below... 
 



 
 

Notice that I have two columns identified as InterDate. This is so that I can 
do a double filter. I want to return any record greater than or equal to 

1/1/2015, but less than or equal to 12/31/2015. On the resulting report, the 

InterDate will only appear once. 
 

To save your report so that you can run it again, click on the ADVANCED 
menu... 

 



 
 

Be sure to save your report in your CryptKeeper folder so that when you run 
backups they are included. 

 



 
 

Then when you go to load your report via the Advanced menu, it will be 
there where you left it. 

 



 
  



Performing Backups 

 
1. From the main application window, choose the Configuration & Preferences feature 
 

 
 
2. Click on the DATA menu 
 
3. Click on the Backup Your Data menu 
 



 
 
4. Choose where you want your backup to be saved. We recommend you 

save these backups to a thumb drive. The archive files are ZIP format so 
they shouldn’t take up too much space. But for best results, we recommend 

at least a 4gb thumb drive. 
 



 
 
5. Click OK to start the backup 
 
6. When finished click OK 
 

Restoring Data from Backups 

 
1. In the event of a system crash or if you are upgrading computers, you’ll need to re-install 
the software and then perform a data restore. 
 
2. From the main application window, choose the Configuration & Preferences feature 
 
3. Click on the DATA menu 
 
4. Click on the Restore Your Data menu 
 
5. You’ll be asked to locate your previously saved ZIP file 
 
6. Click OPEN to start the data restoration 
 
 
IMPORTANT!!! 
You should save the installation routine that you downloaded from our website so that you 
can re-install the software should you ever have a computer crash or are upgrading to a 
new computer. Your registration to the version you’re currently using may not be valid with 

newer versions as they are released, so you’ll want to ensure you have the same version 
your data is registered to so you don’t get locked out of the software. 
 



Importing Data from Online Version 

 
To perform this process you have to start with your online version account. Log into your 
account and then navigate to the View/Edit Your Data feature and then you'll see a new 

page with an EXPORT menu at the top. 
 

 
 

Click on the EXPORT menu. 
 

 
 

Now click on the EXPORT YOUR DATA button. This will collect all the data 
you have in your online account, including data, images and maps. 



 

 
 

All your data will be placed into a unique ZIP file. That zip file link is made 
available to you, but the link is only valid for a short time, so download it as 

soon as you can. 
 

 
 

Now that you've saved your export data, you can open the Desktop Version. 
Click on the Configuration & Preferences feature. 

 



 
 

Then choose the DATA menu and go all the way to the bottom of that listing 
to Import From Online Version. 

 



 
 
This process completely erases EVERYTHING in your current desktop 

database, so if you don't want to do that, quit now!! But if you're ready to 
proceed, answer YES. 

 

 
 
You're asked where you stored your export data. Find the file and click on 

the OPEN button. 
 



 
 
Once all that data is restored the application will need to close to do some 

house-cleaning. 
 

 
 

Re-open the application. If you haven't already registered, you'll need to do 
that immediately. 

 



 
 


